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This document is meant as a short introduction to C++ for those unfamiliar
with the language. We only present the basic knowledge needed in the Wireless
Project Course. For those interested in a more in depth study of the language,
some references can be found at the end of the document. So, let's begin!

1 Introduction

C++ is an object oriented language (like Java for example), meaning that one
can in an easy way structure some operations (functions) in so called objects, a
collection of variables and operations that can store and perform certain tasks.
This approach avoids messy and repetitive code which leads to a more readable
and structured program and with that easier bug detection. In C++ there are
numerous standard libraries that one can use, that contain very common oper-
ations needed in programming. For example, if we want to print the sentence
�Hello, world� on the screen, we write

#include <iostream> // input-output library

int main(){
std::cout << "Hello, world" << std::endl;

}

The �rst line includes the contents in the library <iostream>. The sign //
denotes a comment. The main program begins with the declaration of the func-
tion main, which is the function that contains the code that the C++ program
will start executing. A C++ program always starts at the main function and so
every C++ program must have a main function declared as above. The word
int in front of the function name denotes the return type of the function, i.e.
it says that "the function will return an integer value". More on di�erent types
and functions will come in the following sections. The parentheses after main
specify that we are writing a function, so every function in C++ must have
parentheses after it's name; sometimes there can be additional parameters in
those parentheses that might be used by the code in the function, as we will
see soon. Right after these parentheses we can �nd the program body of the
main function enclosed in braces {}. What is contained within these braces is
what the function does when it is executed. The program code starts at the �rst
program line. std::cout is an output stream (called cout, short for character
out) contained in the standard package inside the iostream library. In order
to access it, we have to specify that it is in the standard package in iostream
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by writing std::cout (we show how to avoid this later in the text). A stream
is an object that is able to handle outputs or inputs in a program, so our cout
stream is an output stream that prints characters onto the screen. Right after
cout comes << which is an operator (basically a function with parameters) that
operates on a stream (in our case cout) and a string ("Hello, world"). Hence
from this one can (after some C++ experience) conclude that the parameters of
the << operator are a stream object and a string. After the "Hello, world" text,
we encounter the operator again, where it now just has the stream std::endl
as a parameter, which starts a new line on the screen after the "Hello, world"
text has been printed. We will in a later section give a small example of why
one de�nes operators and how that can be done, although we will not cover the
whole subject of operators; more about that can be found in the litterature. If
everything in main gets executed correctly, the function returns 0, otherwise it
returns some other integer.

In order to access arguments that are speci�ed by the user at the beginning
of our program, one uses additional parameters in the de�nition of main:

#include <iostream> // input-output library

int main(int argc, char* argv[]) { ... }

The parameter argc denotes the number of arguments feeded into the program
and char* argv[] containts the arguments in a vector called argv. For exam-
ple, writing . /myprog -a myfile.txt (which is the standard way to execute
a program), where myfile.txt is the �le to be executed (and contains the main
function), we have

argc = 3
argv[0] = "myprog"
argv[1] = "-a"
argv[2] = "myfile.txt"
argv[3] = 0 // end marker

That is, the �rst element in the argv vector, located at index 0, is the string
"myprog", the second "-a", and so on. In this way, we can get hold of the strings
written on the command line when executing a program.

Here is an example on how to print on the screen and read from the command
line, prompting the user to input some integers:

#include <iostream>

int main() {
int sum = 0;
int value;
while (std::cin >> value)
sum += value;

std::cout << "Sum is: " << sum << std::endl;
}

The program will wait for the user to enter a number of integers (separated with
white space) and press the enter key. This waiting occurs at the �rst encounter
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of the while loop. After a press of the enter key on the command line, the cin
stream will start reading the string with the integers until it encounters the end
of the string, and each integer from the string is stored in the variable value
and added to the variable sum in the while loop. The end result is that sum will
be the sum of the integers. At the end, the total sum is printed on the screen.

With the knowledge on how to write a simple program, we continue with
explaining variables and data types.

2 Variables, Data Types, Constants

In order to work with variables in C++ (as in Java, C and many other compilable
languages), we must specify what kind of data type a variable has. For example,
if we want to create a variable x that represents the integer 5, i.e. initialize it
with value 5, we write

int x = 5;

The variable will be placed somewhere in the memory and the content of that
memory cell, which the variable represents, will hold the integer 5. Hence, a
variable is in some sense just a "name" for that speci�c memory cell (which is
of course identi�ed by its memory address) that holds, in this case, the integer
5. This way of imagining variables will be very useful later when introducing
pointers and references.

We can similarly just declare an integer variable, without specifying its initial
value:

int y;

In this case, y will implicitly get the initial value 0 by the compiler. Later in
the program we might give some other value to the variable by writing:

y = 10;

Observe that we do not write int y = 10; since the variable has already been
declared once. Writing so would give rise to an error, since variables can be
declared only once in the same program body. One also must remember that
all variables intended to be used must be declared (either with or without
initializing it) before usage.

The int data type is one of the so called primitive data types in C++, i.e.
data types directly supported by the language. Next is a summary of the basic
fundamental primitive data types in C++:

Name Description

char Character or small integer.
short Short Integer.
int Integer.
long Long integer.
bool Boolean value. It can take one of two values: true or false.
double Double precision �oating point number.
long double Long double precision �oating point number.
wchar_t Wide character.
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We can also handle string variables in C++. In order to do that, one must
include the string library. Strings are created with the "" signs. Here is an
example of string declaration and assignment:

#include <iostream>
#include <string> //the string library
using namespace std;

int main ()
{
string mystring; //declare a string variable
mystring = "This is the initial string content";
cout << mystring << endl; //prints the above sentence
mystring = "This is a different string content"; // mystring is assigned a new value
cout << mystring << endl;

}

Observe the line using namespace std. It includes the whole standard pack-
age in the iostream library into the main program so that we avoid writing
std::cout (specifying where the function is found) as we did before.

The variables in a program can have global or local scope, which speci�es
their availability in a program. For example, in the following program

#include <iostream>
using namespace std;

int anInt;
char aCharacter;
int main(){
short age;
float aNumber, anotherOne; //one can declare several variables in a row
cout << "Enter your age: ";
cin >> age; //wait until someone inputs an integer
...

}

The variables above the main function are global variables, meaning that they
can be accessed by the code inside the main function and all other functions
in that �le. The variables inside the main function are local variables and they
can only be accessed by the code in main, not by any other functions outside
main. Similarly, if a function returns a speci�c type, the type has to be speci�ed
before the function, as is the case with int main. Functions that don't return
anything, just perform some task, have void in front of them:

void myfunc(...eventual parameters...){
...
}

More on functions later. In some cases, it is desirable to have constant variables,
i.e., variables whose values are kept constant throughout the program. For
example

const int height = 180;
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creates and initializes an integer variable height with value 180, and that vari-
able is not allowed to get a new value later in the program code.

3 Control Structures

In this section we present how to write di�erent control structures in C++,
which is very similar to other programming languages.

3.1 if and else

An if statement is written as

if(some condition){
... //code
}

For example

if(!(a == 1 || a == 2) && (a < 3)){
cout << "Condition fullfilled!";

}

prints the text "Condition full�lled" on the screen when the logical condition in
the if statement is full�lled. Clearly (?), in the case when a is an integer, we
can just reduce the above if statement to if(a < 1). Associated with the if
statement is the else and else if statements:

if (x > 3){
...//code1
}
else if (x < -3){
...//code2
}
else{
...//code3
}

You guess what the end result will be for di�erent x values. Also, observe the
white space in else if!

3.2 Iteration structures

A for statement that iterates something 20 times:

for(int i = 0; i < 20; i++){
... //code
}

In the above for statement we declare an integer variable i and initialize it
with value 0: int i = 0;. It is to be incremented in steps of 1; this is the i++
expression in the for statement, which is (in function) equivalent to i = i + 1.
The variable must always be less than 20; this is expressed by i < 20 in the
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for statement. Hence, the end result is that the code in the for statement will
be executed exactly 20 times.

A while structure can be used to do a task while some logical condition is
true. It is just as a for statement but without initialization of any counters
that are in the for statement. For example:

char a = 'a';
int b = 10;
int i = 1;
while(i <= 10){
cout << a << " ";
a = a + 1;
i = i + 1;

}

The end result will of course be the 10 �rst letters in the alphabet whitespaced
and printed on the screen. Observe that we have to increment our counter (if
we use one at all, which we do in the above code) in this case, in contrast to
the for loop which does it "on its own".

4 Memory

We will brie�y describe how variables and objects are stored in the memory.
This will be a simpli�ed high level model of how things are arranged in the
memory. Grasping this will help a lot in the coming sections, where we will
introduce concepts (pointers) that are directly related to memory addresses.

The memory of a program is basically divided into two areas: the stack for
local variables in functions and the heap for dynamically allocated variables,
i.e., objects. When some function is entered, memory is allocated on the stack
for parameters of the function and the local variables in it. This memory area
is called an activation record. When the function is exited, the activation record
is deallocated and that memory area can later be reused for other functions or
variables. Here is a pictorial view of the stack memory:

int main() {
int x = 5;
f(x + 1);

}
void f(int a){
int y = 2*a;

}

x 5
a 6
y 12qqq

As seen, the variables are stacked into the memory cells one by one. Later,
when we exit the f function, the memory for a and y is returned (deallocated)
and when exiting the main function the memory cell for x is deallocated. Sim-
ilarly, we can create objects on the stack. Assume we have a class Point that
containes two double variables x and y:
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void f() {
int a = 5;
Point p1(1, 2); //we initialize the x and y

//variables with 1 and 2 respectively
int b = 6;
double xLoc = p1.getX();
}

a 5
p1.x 1.0
p1.y 2.0
b 6

xLoc 1.0

As seen, the objects are stored exactly like variables in the memory, namely, the
variables in the object are stored on the stack. One doesn't have to use the new
command as in Java to create an object and place it on the heap (which is the
case in Java and C++), instead one can do as above and place it on the stack.
This is very common to do in C++. If one instead wants to place an object
in the heap memory, we must in that case have a pointer to the object, which
contains the memory address where that object is located on the heap (more
on pointers in the next section). An object on the heap is similar to a Java
object, but in C++ there is no garbage collector so you must explicitly delete
the object. Here is an example:

void f() {
int a = 5;
Point *p = new Point(1, 2); //a new Point object is created on the heap.

//The pointer p "points" to it
int b = 6;
double xLoc = p->getX();
...
delete p; // here we delete the object on the heap
}

*p means that p is a pointer, p-> is to access a function in the object. The
lifetime of a heap-allocated object is between new and delete; it has nothing to
do with the block structure.

So, to recap, stack memory is used for variables and objects in functions,
while heap memory is used for objects allocated on the heap (with the new
command). With this model of the stack and heap memory, one has a basic
idea of how variables and objects are accessed in a program. This will help in
understanding the concepts in the next section.

5 Arrays, References, Pointers

In this section we explain the very important concepts of pointers and references,
that are distinguishing for the C++ language. References are very useful when,
for example, one writes di�erent functions with parameters. A reference is
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basically a variable that is an alias for some other variable, although it cannot
be changed once declared. This is for example useful when one wants to access
some large object in some function, without having to pass the whole object
to the function, instead just a reference to it. Pointers are variables that are
used for objects allocated on the heap memory, but actually can be used for
much more than so as we will see, although their common usage is just for heap
allocated objects. Also, arrays are treated, which as will be seen are basically
the same as arrays in Java. We begin with the latter.

5.1 Arrays

Arrays are very common structures in high level programming languages. One
who is familiar with Java, C, Matlab and other high level languages has already
encountered them. A general form of declaring an array is the following:

type name[number of elements];

For example

int numbers[10]; //vector with ten integers
char letters[1]; //vector with 1 characted
long longnumbers[24]; //vector with 24 numbers of type long

In order to access a speci�c element in a vector, we write numbers[3], which
gives us the fourth element in the vector since the elements are located with
start at index 0 in the vector. At the instant of declaration, we can also initialize
the array with some values: int numbers[3] = {1,2,3}, which initializes the
vector with 1,2,3 located at index 0,1,2 in the vector, respectively. To change
the value at some speci�c position, we write numbers[2] = 10, which puts 10
on the third position in the vector. Now, it is possible to create two dimensional
arrays/matrices too:

int matrix [3][5];

We handle these arrays in the most natural way, just as the vectors above;
matrix[1][2] = 10 assigns the value 10 to the element in "row" 2 and "col-
umn" 3.

What one must think about when programming in C++ is where some
variables are located in memory. This will be more clari�ed in the aftercoming
sections. In short, the arrays declared in the above example are located on
the stack memory, that is, the memory for that speci�c function we are in
when creating those arrays. So, when leaving the function, the stack memory
is returned and so the arrays (and other variables declared in the function) are
lost and cannot be used outside that function. For this we can use pointers as
will be shown later.

5.2 References

In C++ we have a way to access the same object (same memory location) with
di�erent variables. This is the concept of references. As mentioned earlier, they
are useful as function parameters and also as function return values. A reference
must be initialized when it's created, and once initialized it cannot be changed.
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int ival = 24; //a normal int
int &refval = ival; // refval refers to ival
refval += 2; // adds 2 to ival, just as refval = refval + 2
int ii = refval; // ii becomes 1026, and so does ival!

As seen in the comments above, refval is an "alias" for the variable ival, i.e.,
it is the variable ival but under a di�erent name. We will see how references
can be used with functions in the next section.

5.3 Pointers

A pointer is a sort of variable that points to some memory location and holds
the address of that location. By that, one can change the content of that
memory location and also retrieve its address. The pointer can point to (almost)
anything: a variable of some primitive data type, a variable allocated on the
stack memory, an object from some class, etc. A pointer is declared with a * in
front of its name:

int *ip1; // pointer to an int variable. May also be written int* ip1
double *dp; // pointer to double

We can have pointers to all types that are de�ned, e.g., all the primitive types
or classes de�ned by the user. One way of giving a value to some pointer (not
the common way, as we will see soon) is to use the reference operator, denoted
by &, that retrieves the address of a variable in the memory:

int ival = 1024;
int *pi2 = &ival; //pi2 is now a pointer to the memory location where ival is

Observe that the & sign is also used when declaring references, although in that
case in a totally di�erent concept. In order to access the contents of the memory
which the pointer points to, one uses the dereference operator *:

int ival = 1024;
int *pi2 = &ival;
cout << *pi2 << endl; //prints 1024
*pi2 = 1025; //ival now becomes 1024

Here is an example on how pointers can be used in conjunction with arrays -
we can use pointer arithmetic to access speci�c array elements:

int ia[] = {0, 2, 4, 6, 8};
for (int* ip = ia; ip != ia + 5; ++ip)
cout << *ip << endl;

As seen, we can add integers to the pointer, which changes the address the
pointer points to. The pointer ip starts by pointing at the �rst element in
the array, and is successively incremented to point at other elements. When a
pointer is incremented, the increments are in the size of the addressed data type,
so ip + 1 means ip + sizeof(T) for an array of type T, where sizeof(T) is
the memory size of the type T. For example, T can be int as in the example
above, in which case sizeof(T) = 4 bytes (memory cells).

As we saw in the section about memory, pointers can also point to objects
in the heap memory. Actually, this is the most common usage of pointers; we
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simply must have them in order to access our objects that are located on the
heap. So, recaping the pointer de�nition from that section, a pointer to a heap
has the following declaration structure:

T *p = new T(...); //T is some type that is allocated on the heap,
//e.g., the T can be the Point we had in the Memory section.

The new command creates an object on the heap and returns a pointer to it.
What is important to remember with objects on the heap is that one must delete
them explicitly with the command delete before exiting the function where they
were created. This because C++ does not have a garbage collector as Java does,
so in order to avoid memory over�ow, every created object should be deleted
(maybe one can make an exception in small programs with few objects, but one
should stick to this convention since it can easily be forgotten, if not followed
regularly, in larger programs and then the problem becomes severe). We can
now see how to put arrays on the heap - simply just use a pointer (similar to
Java, but now we have more knowledge about this process). Here is an example
with some function g that creates an array with integer squares:

void g(int n) {
int a;
int *px = new int[n]; // size may be dynamic, that is, defined by a variable
for (size_t i = 0; i < n; ++i)
px[i] = (i + 1) * (i + 1);

...
delete[] px; // note []

}

Basically, px[i] is just the same as px = px + i, which is the way we traversed
stack allocated arrays earlier, but now in a more compact form. The pointer
again points to the �rst element in the array that is on the heap. Also, never
forget to delete the heap allocated array!

It is instructive to compare pointers and references. As seen, pointers hold
a memory adress, while references basically are just an alias for some variable:
changing the value of a reference, changes the value of the variable it is an alias
to. There are some more points that have to be distinguished between pointers
and references:

• Pointers must be deferenced, references must not

• Pointers may be null or unde�ned, not references

• Pointers may be changed to point at other objects, not references

As said at the beginning of this section, pointers can point to almost anything,
actually even functions. This is however regarded as an overcourse for the
Wireless Project Course, so this will be skipped in this summary.

6 Functions

In this section, we will brie�y describe how to write functions in C++. It is
very similar to Java. Functions in C++ have the following format:
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type name (parameter1, parameter2, ...) { statements }

The parameters are stated with a type and a name, for example parameter1
might be char c: char is the type of the parameter and c is its name. Here is
a simple example of the main function and an addition function:

// function example
#include <iostream>
using namespace std;

int main ()
{
int z;
z = addition (5,3);
cout << "The result is " << z;
return 0;

}

int addition (int a, int b)
{
int r;
r=a+b;
return r;

}

We see that the functions are written and called just as in Java. By default,
the arguments passed to a function as parameters are copied to the function.
That is, variables/objects that are sent to a function are copied and their copies
are used in the function, not the original objects. Hence, in this default case,
changing the parameters of the function in the code will not a�ect the original
object that is outside the function. For example:

int main ()
{
int a = 5;
int b = 3;
swap(a,b);

}
void swap(int a, int b){
int temp;
temp = a;
a = b;
b = temp;

}

In this case, the swapping that occurs in the swap function will not a�ect the
original a and b variables in the main function, just as in Java. However, if we
use references as our function parameters, then the arguments will be passed by
reference:

void swap(int &a, int &b){
int temp;
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temp = a;
a = b; //a in main is now 3
b = temp; //b in main is now 5

}

int main ()
{
int a = 5;
int b = 3;
swap(a,b);

}

Similarly, we can pass pointers into functions

void f(int x, const Point *p) {
x++;
double y = x + p->getX();

}
int main() {
int x = 2;
Point *q = new Point(5, 10);
f(x, q);

}

Observe that we cannot change the object that the pointer p points to in f, since
it is speci�ed to be constant in f. Instead, if one wants to change the integer the
pointer points to, but wants to keep the pointer constant (i.e. so that it always
points to the same variable/memory address), one writes int * const. Now for
example, if we wrote const int &a and const int &b in function swap, we
could not have performed the above operations in swap since we cannot change
the variables a and b in swap because they are passed as constants to the
function. So when should one use pointer parameters or reference parameters
in functions? A common rule is to use reference parameters when a program
uses stack-allocated objects. If the program must use heap-allocated objects,
write functions with pointer parameters. If we want to pass arrays as arguments
to functions, we pass a pointer to the �rst element of the array. Also, we must
pass the size of the array as an argument, since we do not know in advance how
many elements an array contains.

void printValues(const int *ia, int n) {
for (int i = 0; i != n; ++i)
std::cout << ia[i] << std::endl;

}

Note that const int* is a variable pointer (i.e., we can change the pointer to
point somewhere else) to a constant integer. The following implementation of
printValues is equivalent:

void printValues(const int *ia, size_t n) {
const int *end = ia + n;
for (; ia != end; ++ia)
std::cout << *ia << std::endl;

}
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As expected, functions can return references and pointers. This is however
mainly used when implementing and overriding (rede�ning) di�erent opera-
tors. So in most cases (mainly for our purposes) we do not need these kind of
functions. However, it is instructive to see how this works - one gets a better
"feeling" on how to "think in C++". For example if we want to specify addition
between two complex numbers represented by a class Complex, we would in that
class have a function Complex operator+(const Complex &c) that would im-
plement complex number addition and return the resulting complex number. In
this case we are not returning a reference to the new, resulting complex object,
instead we return the object itself - this because if we return a reference to the
resulting object created in operator+, we would have a reference to an unde-
�ned memory location (which will result in an error) since the created object
in operator+ will be deleted once we exit the function. Here is an example of
how to implement your own operator:

class Complex {
public:
Complex(double re, double im);
Complex operator+(const Complex& c);

private:
double re;
double im;

}

This is our class de�nition that is placed in a �le on it its own (more on this
later). Now comes the implementation of the operator:

Complex Complex::operator+(const Complex& c) {
return Complex(re + c.re, im + c.im);

}

A small explanation to why the operator looks in that way. If we now somewhere
in our program have a code snippet like Complex c = c1 + c2; where c1 and
c2 are two complex numbers, the compiler will (when compiling the program) in-
terpret the expression to the right of the equality sign as c1.operator+(c2);.
Hence, it will call the operator+ function in the Complex class, with c2 as an
argument to the function - this explains why the operator has a complex num-
ber as a parameter. Since we will not change the argument in the function,
we specify the parameter to be const. The only thing the operator needs to
do is to create a new complex number that is the sum of the two and return
a copy of the object, which then in our code snippet is "caught" by c. One
might then ask: shouldn't we also de�ne how the = operator, which is used in
the code snippet, should behave for our complex numbers? Actually, as will be
mentioned again in the next section, the compiler already takes care of that by
default: it copies the real and imaginary values in the "right hand side object"
to the real and imaginary values in c. We will encounter a similar example in
the next section. Hence, if you want to use operations as +,-,=,+=, etc., on
your own objects, you have to (in many cases) de�ne them on your own. So
what is important to know when implementing operators is how the compiler
interprets di�erent code lines. With that knowledge one can fairly easy know
how the operator functions will look like in a class. So in a relatively easy way,
we have de�ned our own addition operator for complex numbers!
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Now if we instead want to de�ne our own += operator (compare to the one
for int numbers above) for complex numbers, we do it in the following manner:

class Complex {
private:
int r;
int c;

public:
Complex& operator+=(const Complex &cnbr) {
r = r + cnbr.r;
c = c + cnbr.c;
return *this;

}
...

}

What it does is that adds the real and complex values of the other complex
number to the existing one. So, somewhere in the program we might have the
following code snippet:

Complex a, b;
a += b; // compiled into a.operator+=(b);

Hence, we see that the C++ compiler will compile a += b; into a.operator+=(b),
i.e., it will call the above implemented Complex &operator+= which returns a
reference to the "new" version of a. This new version is not "caught" by any
other variable as can be seen, because it is not needed (a has still been updated,
it's just that we do not catch the reference thrown back from operator+=). In-
stead, the real use of this returned reference is when writing code like c += (a += b),
i.e., when we are using nested versions of the operator +=. Observe that the ref-
erence becomes crucial in this case: (a += b) will return a reference to the new
a which is then used in c +=. The reader now knows quite a lot on how one
might de�ne own operators for di�erent purposes, which can be quite useful
sometimes. We have not covered all aspects of operator overloading, more on
this can be found in [?]. Also, we have seen class de�nition examples, which we
will study more in the next section.

As said, we can also return pointers. For example, we can create an object
on the heap and return a pointer to it, in order to use it outside the function
where it was created:

Complex *newComplex(){
Complex *c = new Complex(1,1); //create a new Complex number representing 1 + i

//and place it on the heap
return c; //return a pointer to the number

}

What one must think about is to never return a reference or a pointer to a
local object in the function. This is (as mentioned above) because the returned
pointer/reference will refer to memory that has been deallocated. What is
also important to remember is that functions must be declared or implemented
before they are used in some other function, so that the compiler recognizes the
function when it encounters its usage. This is exactly as with classes and can
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be done by placing the function de�nition in a special header �le (format .h)
and its de�nition (implementation) in some implementation �le (format .cpp in
Windows). For example

void printValues(const int*, size_t); // declaration, goes
// in header file

void printValues(const int* ia, size_t n) { // definition in
// some other file

...
}

Of course, one can also do as in our previous examples above, by implementing
our function before main so that the compiler already can see the function before
it encounters it in main (also, the implementation can be skipped, it is just
enough to declare it as in above example in order for the program to compile).

7 Classes, Objects

Writing own classes is very similar to Java. We have already encountered (in
earlier sections) how to create objects of classes: one can place them on the stack
memory or the heap memory. In C++, one often de�nes the class before im-
plementing it. In the above section we had the declaration and implementation
in one �le (when implementing Complex). This is OK for small classes, but it is
better to follow the conventions and separate class de�nitions and class imple-
mentation. The de�nition of a class is done in a header �le (extension .h), where
one speci�es which variables and functions the class will have. The functions
themselves are implemented in some other �le (extension .cpp in Windows). For
example, the header �le for the Point class we had in earlier examples would
look like:

class Point{
public:
Point(double x, double y); //constructor
double getX() const; //const means that the function does not modify

//the state of the object,i.e., changes the
//value of the variables (attributes) in the class

double getY() const;
private:
double x; //attribute
double y;

}; //note the semicolon here

We have a public and private section, which is just as in Java: the variables
and functions in the public section are accessable from outside of the object,
while the variables and functions under private are not. Also, functions that
are not changing the state of the object, called accessor functions, should be
declared const as above. The above class de�nition (declaration) is placed in a
header �le. The functions, that are placed in a .cpp �le, are then implemented:

Point::Point(double ix, double iy){
x = ix;
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y = iy;
}
double Point::getX() const{
return x;

}
double Point::getY() const{
return y;

}

When implementing the functions in the .cpp �le, one has to include the header
�le where the class de�nition is. Observe our usage of the access operator ::
(which we used in the introduction), which is needed in this case since we have
to specify that the functions we are implementing are from the Point class. If
we instead have a class Line that uses two dynamically allocated Point objects
to represent the start and end points, we must also implement a destructor for
the Line class, that deletes the pointers when the line object dissapears:

class Line {
public:
Line(double x1, double y1, double x2, double y2);
~Line(); // destructor

private:
Point *start; // start point
Point *end; // end point

};

The destructor is called automatically when the line object is destroyed and is
responsible for cleaning up, i.e., in this case, deleting the Point objects. The
implementation (in a .cpp �le) runs as follows:

Line::Line(double x1, double y1, double x2, double y2){
start = new Point(x1,y1);
end = new Point(x2,y2);

}
Line::~Line(){
delete start;
delete end;

}

Without the destructor, the start and end objects would never be deleted and
one would have a memory leak. Here is an example:

void f() {
Line l1(100,134,200,210);
Line l2(220,221,301,300);
Line *pl = new Line(10,20,30,40);
...
delete pl; // destructor for *pl is called

} // destructors for l2, l1 are called
// (in reverse order of creation)

We can have several constructors in a class. For example, a Person class:
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class Person {
public:
Person(const string&); // initialize with name
Person(); // no name
...

};
void f() {
Person p1("Bob"); // calls Person(string)
Person anon; // calls Person()
Person *pp1 = new Person("Joe"); // calls Person(string)
Person *pp2 = new Person; // calls Person()

...
}

A few words on reference and value semantics. In Java, all objects are manip-
ulated via reference variables (pointers in C++). You may assign pointers to
pointer variables but assignments never touch the �inside� of the objects.

Car *myCar = new Car("ABC123");
Car *yourCar = new Car("XYZ789");
...
delete myCar; // my car to the scrapheap
myCar = yourCar; // I buy your car
yourCar = 0; // you don�t own a car now

This is called reference semantics and it is often the preferred way to manipulate
with objects. However, in some cases you want to change the contents of the
objects when doing assignments as above. Here is an example with strings.
Consider �rst manipulating the string with pointers:

string *s1 = new string("asdfg");
string *s2 = s1; // two pointers to the same object
s1->erase(0, 1); // erase the first character of s1. erase is,

// as one can see, a function in the string class
cout << *s1 << endl; // prints sdfg
cout << *s2 << endl; // also prints sdfg, maybe unexpectedly

// since you haven't touched s2

So in this string case, it would be more natural if it s1 actually got copied to
s2. This is accomplished by the following code:

string s1 = "asdfg";
string s2 = s1; // copy the object
s1.erase(0, 1); // only s1 is modified

This is called value semantics, since we are copying the "inside" of the object,
not a reference (a pointer in the cases above) to it as with reference seman-
tics. We have encountered this earlier in the examples with complex numbers
Complex c = c1 + c2;. A code line like string s2 = s1; or Complex c1 = c2;
will by the compiler be interpreted as string(s1) and Complex(c2) respec-
tively, i.e., the copy constructor for the string and Complex classes will be
invoked. As mentioned, a default copy constructor is already provided for all
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objects by the compiler: it basically just copies the attribute values from one
object to the other one. This is in many cases OK, as for example with our
Complex and Point classes where the number values are copied, but if one has
a class that contains pointers to some other objects, then using the default copy
constructor might be dangerous. For example, a class A that has pointers to
some objects on the heap. Writing A a1 = a2; will make the default copy con-
structor copy the pointer values (a memory address) from a2 to a1, but now we
would have two objects of class A with pointers in them pointing to the same
objects! So by deleting one of those A objects, for example a2, the destructor
would immediately (if de�ned properly) delete those "internal" objects, and we
would end up with having a1 containing pointers pointing to nothing, which is of
course a disaster! So, in these cases, one has to de�ne an own copy constructor
to cope with these problems. More on this in [?].

7.1 Inheritance

Inheritance in C++ is similar to Java inheritance. Here we will call a superclass
(in Java) a base class and a subclass a derived class. Here is the common
structure for inheritance in C++:

class Car : public Vehicle {
...
}

C++ has also multiple, private and protected inheritance, but they are not
needed for our purposes; more on that in [?],[?]. In Java, the type of the
object determines which implementation of a function that is called. This is
called dynamic binding To achieve this in C++ you must specify the function
as virtual:

class A {
public:
void f();
virtual void g(); //virtual function

};
class B : public A {
public:
void f();
void g();

};

Here is an example of what happens in di�erent scenarios with those two classes:

void func() {
A *pa = new A;
pa->f(); // calls A::f
pa->g(); // calls A::g
A *pb = new B;
pb->f(); // calls A::f, f is not virtual
pb->g(); // calls B::g, g is virtual
...
delete pa;
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delete pb;
}

So, as we see

• non-virtual function: the type of the pointer determines which function is
called.

• virtual function: the type of the object determines which function is called.

The constructor in a derived class must explicitly call the constructor in the
base class (done with super(...) in Java). This is done in the following way:

class Shape {
public:
Shape(int ix, int iy){
x = ix;
y = iy;}
...
};
class Square : public Shape {
public:
Square(int ix, int iy, int is) : Shape(ix,iy), s(is) {}
...
};

Observe the di�erence in initialization done by the two constructors. It is com-
mon to write as the constructor in Shape. The way of initializing as in the
Square class is referred to as a constructor initialization list. s(is) is the same
as s = is;. It is very handy to use if one wants to initialize just a few number
of variables. In the above case of inheritance, one must use the constructor
initialization list to call the Shape constructor.

Consider now the following example:

Shape sh(1, 2);
Square sq(2, 3, 5);
sh = sq; // allowed, but Square members are not copied (this is called "slicing")
sq = sh; // not allowed, would leave the Square members undefined

Hence, one must be careful with assignments between base and derived classes.
Similar situations can occur in functions:

void f(const Shape s) {
...
s.draw(); // Shape::draw is always called
}

A way to solve this case is to write the function as

void f(const Shape &s) {
...
s.draw();
}

19



That is, just use a Shapereference for the passed object! Now suddenly

Shape sh;
Square sq;
f(sh); // calls Shape::draw
f(sq); // calls Square::draw

Hence, slicing does not occur in this case, since the object is not passed by value,
i.e., value semantics is not used when passing the object as a parameter to the
function in this case, in contrast to the case when not having a reference as a
parameter, but instead a Shape object (as in the previous example).

Suppose now that a base class A and a derived class B manage separate
resources (i.e., control separate objects by for example having their own pointers
to them). Then each class needs a destructor:

class A {
public:
~A();
...

};
class B : public A {
public:
~B();
...

};

When a B object is destroyed and the destructor ~B() is called, the destructor
for the base class, ~A(), is automatically called. This continues up to the root
of the inheritance tree. But if we now write like

A *pa = new B;
...
delete pa;

the wrong destructor, ~A(), will be called when pa is deleted. To correct this
error, you must make the destructor virtual: virtual ~A();. So a rule of
thumb is: if a class has derived classes, or if you suspect that you later will add
derived classes, make the destructor virtual.

As in Java, a function in a class may be speci�ed as abstract, which means
that the function will be implemented in one of the derived classes. These
abstract functions are called "pure virtual" in C++. In C++ you add = 0 after
the function signature to specify that it is a pure virtual function:

class Shape {
public:
virtual void draw() const = 0; // abstract function
...

};
class Square : public Shape {
public:
void draw() const; // concrete. Implements the draw function.
...

};
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And remember, just as in Java, you cannot create an object of a class that
containt abstract functions. Now, this was basically everything (and maybe
even more) that one needs to know about classes and objects in C++ for the
Wireless Project Course. We would like to say that the best way of learning a
programming language (and programming too) is to practice a lot, so please do
so!

A How to make IT++ work

IT++ is a C++ library, developed at Chalmers in Sweden, that contains relevant
communication classes used when programming communication systems in C++
[?]. In order to use this library, we must do a number of steps in Visual Studio,
which makes the IT++ library available for use in a project. We assume that
ACML is already installed on the computers. Then these steps should be done
when a project has been created in Visual Studio:

• The IT++ include directory must be de�ned. Go to: Tools→ Options→
Projects and Solutions → VC++ Directories → Include �les. Add path
to IT++ directory, e.g., "C:\itpp-4.0.3".

• The IT++ library directory must be de�ned. Go to: Tools → Options →
Projects and Solutions → VC++ Directories → Library �les. There add
the path to the library, e.g., "C:\itpp-4.0.3\win32\lib".

• In library �les (as above) add $(LIB) as another path.

• Linking with IT++ and ACML must be set up (for each project). Go to:
Project → Properties → Con�guration Properties → Linker → Input →
Additional Dependencies. Add "itpp.lib" (to be sure, check the name of
the library �le, can be "itpp_debug.lib") and "libacml_dll.lib".

• Go to: Projects → Properties → Con�guration Properties → C/C++ →
Preprocessor → Processor De�nitions. There, add the following:

_CRT_SECURE_NO_DEPRECATE

_CRT_NONSTDC_NO_DEPRECATE

HAVE_ACML
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